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Preface
Administering Licenses for Rational Software provides you with the technical
information you need to install and configure license keys, install and configure the
FLEXlm license server software, and troubleshoot problems related to licensing
Rational Software products.

Rational Suite delivers a comprehensive set of integrated tools that embody software
engineering best practices and span the entire software development life cycle.
Rational Suite's unparalleled level of integration improves communication both
within teams and across team boundaries, reducing development time and improving
software quality.

Audience

This guide is intended for system administrators. This book assumes knowledge of
Microsoft Windows and its conventions and a familiarity with client-server
environments.

Other Resources

■ Online Help is available for Rational Suite.

From a Suite tool, select an option from the Help menu.

■ All manuals are available online, either in HTML or PDF format. The online
manuals are on the Rational Solutions for Windows Online Documentation CD.

■ To send feedback about documentation for Rational products, please send e-mail
to techpubs@rational.com.

■ For more information about Rational Software technical publications, see:
http://www.rational.com/documentation.

■ For more information on training opportunities, see the Rational University Web
site: http://www.rational.com/university.
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Contacting Rational Technical Support

If you have questions about installing, using, or maintaining this product, contact
Rational Technical Support as follows:

Note: When you contact Rational Technical Support, please be prepared to supply the
following information:

■ Your name, telephone number, and company name

■ Your computer’s make and model

■ Your operating system and version number

■ Product release number and serial number

■ Your case ID number (if you are following up on a previously-reported problem)

Contacting Rational Licensing Technical Support

If you have questions about acquiring license keys for your Rational Software
products, contact Rational Licensing Support as follows:

Your Location Telephone Facsimile E-mail

North America (800) 433-5444
(toll free)

(408) 863-4000
Cupertino, CA

(781) 676-2460
Lexington, MA

support@rational.com

Europe, Middle
East, Africa

+31 (0) 20-4546-200
Netherlands

+31 (0) 20-4545-201
Netherlands

support@europe.rational.com

Asia Pacific +61-2-9419-0111
Australia

+61-2-9419-0123
Australia

support@apac.rational.com

Your Location Telephone Facsimile E-mail

Asia Pacific +61-2-9419-0111 +61-2-9419-0123 license@apac.rational.com

Asia Pacific
(Japan)

+61-2-9419-0111 +61-2-9419-0123 license@japan.rational.com

Asia Pacific
(Korea)

+82-2-556-9420 +82-2-556-9426 license@apac.rational.com
Contacting Rational Technical Support xi



Asia Pacific
(Mainland China,
Hong Kong, and
Taiwan)

+61-2-9419-0111 +61-2-9419-0123 license@china.rational.com

Europe
Middle East
Africa

+31 20 4546 200 +31 20 4546 202 license@europe.rational.com

North American
(East Coast) South
America

800-433-5444
(toll free)

781-676-2460 license@rational.com

North America
(West Coast)
Central America

800-433-5444
(toll free)

408-863-4001 license@rational.com

Your Location Telephone Facsimile E-mail
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1Using This Guide
This manual provides comprehensive information about licensing for Rational
products. The information in this document pertains to products licensed using
Rational Common Licensing for Windows unless otherwise noted.

This manual includes the following topics:

■ Brief descriptions of Rational licensing tools: Rational AccountLink, License Key
Certificate, “Getting Started with Rational Software”, License Key Administrator,
Rational Software Setup program.

■ Definitions for license types and license key types.

■ Instructions for installing and configuring a floating license server and floating
license keys.

■ Requirements for acquiring and installing permanent license keys.

■ Instructions for installing node-locked license keys.

■ Information about other supported FLEXlm features and configurations.

■ Descriptions of and solutions for license installation problems and errors.

■ Descriptions of Rational Common Licensing components and mechanics.

■ References to additional sources of help.

This chapter provides an overview of Rational licensing tools that you use to acquire
permanent license keys, a brief description of the Rational License Key Administrator,
and a quick start guide that helps you navigate through this manual.
1



Rational Licensing Tools

Using Rational AccountLink to Request Permanent License Keys

AccountLink (http://www.rational.com/accountlink) is a Web tool that you can use to
manage your permanent (or Term License Agreement) license keys. AccountLink
offers three license transactions:

■ Get License Key(s)
■ Return License Key(s)
■ Request a Copy of a License File

When you register your Rational products to a specific system with AccountLink, Rational
e-mails a license file to the contact e-mail address that you designate in AccountLink’s License
Contact page. If AccountLink is unavailable, call Rational Licensing Support. See Contacting
Rational Licensing Technical Support on page xi for phone numbers.

Note: AccountLink does not support temporary license transactions.

Using Your Rational License Key Certificate

To get your permanent or TLA license keys, you need to supply information from your
Rational License Key Certificate. This certificate is enclosed in a large green envelope
in your shipment. The information, especially the Rational Account Number, on this
certificate verifies your company has purchased licenses to run Rational products.

Using “Getting Started with Rational Software”

To help you understand more about these license transactions, the “Getting Started
with Rational Software” pages provide quick start instructions and examples for
obtaining and installing Rational license keys. You find “Getting Started with Rational
Software” at www.rational.com. Click Support > Support Services > Getting Started.

Using the Rational License Key Administrator

The Rational License Key Administrator (LKAD) is installed with your Rational
software and with your FLEXlm license server software. This Rational program
provides an interface to Rational Common Licensing features. You can use the LKAD
to enter or import license keys and change your license configuration.

■ To access the LKAD on a client system, click Start > Programs > Rational product
name > Rational License Key Administrator.

■ To access the LKAD on a license server system, click Start > Programs > GLOBEtrotter
FLEXlm License Server > Rational License Key Administrator.
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The online Help explains how to use the LKAD to review and modify your license
configuration. The LKAD Help also provides information about configuring the
FLEXlm License Server software. To access the Help, click Help in the License Key
Administrator’s main menu or open <Install Path>\Rational\Common\licadmin.hlp.

Administrator Privileges for the LKAD

The Rational License Key Administrator (LKAD) is installed with every Rational
product and with the FLEXlm License Server software. What you can do in the LKAD
depends on the administrator privileges that you have. Grayed out menu options in
the LKAD Wizard, menu bar, or button bar indicate limited privileges. To find out
which specific privileges are missing, see the LKAD online Help. Then request the
missing privileges from your system administrator.

Using the Rational Software Setup Program

The Rational Software Setup program not only installs Rational software but can also
help you with some important licensing tasks, such as installing the FLEXlm License
Server software, importing a Rational license file, and specifying the FLEXlm License
Server. The Installing Rational Suite manual provides recommendations for when to set
up your licensing and explains when these tasks can be done during the installation
procedure.

Rational Common Licensing Roadmap

To help you install and configure Rational licenses, Table 1 directs you to Web
resources and specific chapters in this manual.

Table 1 Rational Common Licensing Roadmap

To See

Acquire permanent (floating
or node-locked) license keys

Getting Started with Rational Software at
http://www.rational.com/support/gettingstarted/index.jsp
and AccountLink at http://www.rational.com/accountlink
Or Before You Install on page 5 and Getting Permanent License
Keys on page 11 in this manual.

Install floating and floating
named-user license keys

Getting Started with Rational Software at
http://www.rational.com/support/gettingstarted/index.jsp
and AccountLink at http://www.rational.com/accountlink
Or Before You Install on page 5 and Installing Floating and
Named-User Licenses on page 13 in this manual
Rational Common Licensing Roadmap 3



Install node-locked license
keys

Getting Started with Rational Software at
http://www.rational.com/support/gettingstarted/index.jsp
and AccountLink at http://www.rational.com/accountlink
Or Before You Install on page 5 and Installing Node-Locked
Licenses on page 25 in this manual

Install a temporary (floating
or node-locked) key for
evaluating a Rational product

Getting Started with Rational Software at
http://www.rational.com/support/gettingstarted/index.jsp
For floating licenses, see Before You Install on page 5 and
Installing Floating and Named-User Licenses on page 13 in this
manual.

For node-locked licenses, see Before You Install on page 5 and
Installing Node-Locked Licenses on page 25 in this manual.

Configure redundant license
servers

Installing Floating and Named-User Licenses on page 13

Change the order in which
Rational products, such as
RequisiteWeb and ClearQuest
Web, use licenses

Licensing Multiple Suites and Point-Products on page 32

Use other supported FLEXlm
features and configurations,
for example, returning or
moving license keys

Using Other License Configurations on page 29

Understand license
installation problems and
error messages

Troubleshooting Licenses on page 35

Understand the mechanics of
Rational Licensing

Understanding Rational Licensing Components on page 43

Table 1 Rational Common Licensing Roadmap

To See
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2Before You Install
This chapter describes Rational Common Licensing for Windows products, basic
Common Licensing terms, and supported license configurations. This information
will help you prepare the licensing configuration at your site as well as help you
understand Rational Common Licensing.

Note: To find more definitions of Rational Common Licensing terms, see the Licensing
Glossary on page 61.

The Rational Common Licensing Model

Rational Software uses FLEXlm, a software-based license management tool from
GLOBEtrotter, Inc. FLEXlm provides users with a powerful and flexible mechanism
for managing licensing.

GLOBEtrotter’s FLEXlm license management software offers software vendors a wide
variety of features and options. This allows vendors such as Rational Software to
selectively build a customized licensing model by implementing the FLEXlm features
that best meets their business needs.

What are Node-Locked and Floating Licenses?

Rational supports both node-locked and floating licenses. Node-locked licenses are
restricted to an individual system. Floating licenses can be shared by multiple users
and multiple systems, with one person using a license at a time.

When users install Rational products on their systems, the Rational Software Setup
program automatically installs the FLEXlm licensing software (FLEXlm License Server
software is not installed automatically). The licensing software lets these systems use
either node-locked or floating licenses. (Table 2 explains node-locked and floating
licenses in depth.)

Note: Users need floating license keys from a Web Server to run Rational ClearQuest
Web and Rational RequisiteWeb on Web clients.
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License Types

Table 2 defines the basic types of licenses supported by Rational.

Table 2 License Types

License Type Description Notes

Node-locked ■ A node-locked license is
configured for a specific system. It
allows a user to run a Rational
product only on that specified
system.

■ With FLEXlm, vendors can deliver
two types of node-locked license
keys: uncounted and counted.
Rational supports uncounted
node-locked licenses for Windows
products only. Rational refers to
uncounted node-locked license
keys for Windows products as
node-locked license keys.

■ Because these license keys do not
use a FLEXlm license server, the
user may run multiple sessions of
a Rational product concurrently
using a single key.

■ To move a node-locked license to
another system, you must
“remove” the license key from the
old system and request a new
license key for the new system.
For a more detailed explanation,
see Moving License Keys on page 33
and Removing License Keys on
page 34.

Rational also issues node-locked licenses for
Rational products that run on UNIX platforms.
You can request Windows or UNIX node-locked
license keys through AccountLink at
http://www.rational.com/accountlink.

Node-locked Rational products on UNIX (that
use Rational Common Licensing) are licensed
with counted node-locked license keys.
■ Unlike uncounted node-locked licenses, you

manage counted node-locked licenses with a
FLEXlm license server.

■ Unlike floating license keys, uncounted
node-locked keys can only be used on the
system for which they are licensed.

Clients connect to the license server and acquire
a counted node-locked license specific to their
machine. This process is the same as the one
used to acquire floating license keys.

Essentially, a counted node-locked license key is
a floating license key that can only be used on a
specific host.
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What are Permanent and Temporary License Keys?

When you register Rational products to specific systems (license server or client) in
AccountLink, Rational generates license keys and e-mails these permanent license
keys in a license file to you. The permanent keys let you use the Rational products for
an indefinite period of time. However, Rational assigns an expiration date to the
license keys if your company has negotiated a Term License Agreement (TLA).
Technically TLA keys are not permanent, but Rational groups TLA licenses in the
permanent license category.

To use Rational products for an evaluation period or if you expect a delay in receiving
your permanent keys, you can install the temporary license key provided in your
Rationa License Key Certificate. Because Rational has not generated the temporary
key for a specific system, you can use it on any system until the specified expiration
date.

So what does this have to do with floating and node-locked licenses? Permanent and
temporary license keys can be floating or node-locked. Regardless of license key type
(permanent or temporary), the installation and set up of floating and node-locked
license keys remains the same. You still install floating licenses on a license server and
node-locked licenses on a client. The only difference is that a temporary key is not
generated for a specific system while a permanent key is registered to a specific
system.

Floating ■ A system administrator installs
the FLEXlm License Server
software on one or three systems.
The administrator then installs the
floating licenses on the license
server system.

■ The floating licenses are shared
among all users of Rational
products.

■ To move a floating license to
another license server, you must
“remove” the license key from the
old license server and request a
new license key for the new
license server. For a more detailed
explanation, see Moving License
Keys on page 33 and Removing
License Keys on page 34.

Rational also supports Named-User floating
licenses for Rational Purify, Quantify, and
PureCoverage. This configuration assigns
licenses to specific users. That is, only specific
users can request floating license keys from the
license server. For more information, see
Configuring the Server for Named-User Floating
Licenses on page 21.

Table 2 License Types

License Type Description Notes
The Rational Common Licensing Model 7



Table 3 defines the types of license keys used by Rational licensing.
.

What are Emergency and Evaluation License Keys?

Emergency and evaluation license keys are temporary license keys. They can be
floating or node-locked. They are short-term licenses that are not generated for a
specific system. For more information about temporary license keys, see What are
Permanent and Temporary License Keys? on page 7.

Table 3 License Key Types

License Key
Type

Description Notes

Permanent ■ A license issued to a customer for
running Rational products. Permanent
licenses are keyed to a specific
Rational product and specific system.

■ Permanent license keys can be
node-locked or floating. The user
installs a node-locked permanent key
on a system on which the user runs
Rational software. Floating permanent
keys are installed on a FLEXlm license
server system.

Rational issues permanent
node-locked or floating keys
upon request. Use
AccountLink at
www.rational.com
/accountlink to acquire your
license keys.

Temporary ■ A time-limited license issued to a
customer for running Rational
products. Temporary licenses are not
keyed to a specific system.

■ Temporary license keys can be
node-locked or floating. The user
installs a node-locked temporary key
on a system on which the user runs
Rational software. Floating temporary
keys are installed on a FLEXlm license
server system.

The expiration date for a
temporary key is noted on
the License Key Certificate
included with the Rational
product shipment.

TLA (Term
License
Agreement)

■ Variation of a Permanent Key. TLAs
are issued to allow users access to
Rational software for a negotiated
period of time.

TLAs are issued by the
Rational Sales Team. To
obtain TLAs for your
organization, contact your
local Rational Sales Team.
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Supported License Configurations

This section describes FLEXlm and network configurations supported by Rational
Software. The term “supported” refers to a licensing configuration that Rational has
tested and guarantees will work under normal operating conditions. This applies to
configurations that the software was designed to handle. This also applies to
configurations for which the software was not specifically designed, but with which it
will work with some manual intervention.

FLEXlm Licensing Configurations

The following table lists license configurations that Rational does support as well as
configurations Rational plans to support.

Table 4 FLEXlm Licensing Configurations

Configuration Platform Supported?

Node-locked license key in a file Windows This configuration is fully supported
by Rational with Rational Common
Licensing 1.0 and beyond.

Node-locked license key in a file UNIX This configuration is fully supported
by Rational with Rational Common
Licensing 1.0 and beyond.

FLEXlm server and Rational
Windows products installed on a
single system

Windows This configuration is fully supported
by Rational with Rational Common
Licensing 1.5.

FLEXlm server and Rational UNIX
products installed on a single system

UNIX This configuration is fully supported
by Rational with Rational Common
Licensing 1.0 and beyond.

Floating licenses with redundant
license servers

Windows servers;

UNIX clients

This configuration is not yet officially
supported by Rational.

Floating licenses with redundant
servers

UNIX servers;

UNIX clients

Redundant servers are supported on
UNIX platforms by Rational Common
Licensing.

Floating licenses for Windows
products.

UNIX server This configuration is supported with
Rational Common Licensing 1.5.
Supported License Configurations 9



Next Steps

With your understanding of Rational Common Licensing and your License Key
Certificate in hand, you are ready to get your permanent license keys. If you do not
have an internet connection, see Getting Permanent License Keys on page 11. If you
already have your license keys, see Installing Floating and Named-User Licenses on
page 13 or Installing Node-Locked Licenses on page 25.
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3Getting Permanent
License Keys
Although this chapter gives customers, who do not have access to the internet,
instructions for obtaining license keys by fax, Rational recommends that you use
Rational AccountLink (www.rational.com/accountlink) to request permanent license keys.
This chapter also describes how Rational licensing services sends you permanent
license keys.

If you have already acquired your permanent keys, look at the table in Next Steps on
page 12.

Requesting Permanent License Keys

This section summarizes the steps for getting a node-locked or floating permanent
license key when you do not have an internet connection or AccountLink is
unavailable.

1 Find your License Key Certificate in your Rational product shipment.

Print the license request form. To print the form, either install the Rational product
that you purchased and open the license_request form. htm in the Rational
common directory (<Rational_directory>\common\license_request_form.htm) with any
browser or open the file in the Rational installation CD
(<cd_drive>\common\license_request_form.htm). The French and German versions of
this fax form are in the same locations:

■ <Rational_directory>\common\license_request_form_french.htm
■ <cd_drive>\common\license_request_form_french.htm
■ <Rational_directory>\common\license_request_form_german.htm
■ <cd_drive>\common\license_request_form_german.htm

2 Use the License Key Certificate to fill out the form. Make sure that the contact,
Rational account number, product, licensing, and host information are correct.
Any errors will cause delays in receiving your license keys.
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3 Fax the request to Rational. See Contacting Rational Licensing Technical Support on
page xi for fax and phone numbers.

Note: Call Rational Licensing Support if you cannot use Rational AccountLink or the
fax form to order your permanent license keys. See Contacting Rational Licensing
Technical Support on page xi for phone numbers.

Receiving Permanent License Keys

If you request a new license using AccountLink, Rational will send you a license key
file via e-mail. If you request a permanent license key by fax and you have specified
an e-mail address in your contact information, you will receive a license key file via
e-mail. You can copy the permanent license file from the e-mail enabled system and
install it on the system that is not e-mail enabled.

If you cannot provide an e-mail address, contact Rational Licensing Support. See
Contacting Rational Licensing Technical Support on page xi for the phone numbers.

Next Steps

The following table directs you to the chapters you can consult to install your license
keys.

To See

Install floating and floating
named-user license keys

Before You Install on page 5 and Installing Floating and
Named-User Licenses on page 13 in this manual

Install node-locked license keys Before You Install on page 5 and Installing Node-Locked
Licenses on page 25 in this manual

Install a temporary (floating or
node-locked) key for evaluating a
Rational product

Note: If you expect delays in
receiving your permanent license
key, install the temporary key listed
in your Rational License Key
Certificate. When you receive your
permanent license key, you do not
have remove the temporary key.

For floating licenses, see Before You Install on page 5
and Installing Floating and Named-User Licenses on
page 13 in this manual.

For node-locked licenses, see Before You Install on
page 5 and Installing Node-Locked Licenses on page 25 in
this manual.
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4Installing Floating and
Named-User Licenses
Floating licenses, including named-user floating licenses, let you manage and
maintain licenses on a single license server or redundant license servers.

This chapter describes how to set up and run Rational’s floating license services:

■ Making sure your floating licenses can work with the network configuration you
have set up.

■ Installing FLEXlm License Server software.

■ Installing permanent, Term License Agreement (TLA), and evaluation or
temporary license keys on the license server.

■ Starting the FLEXlm License Server software.

■ Configuring the license server for named-user floating licenses.

■ Configuring client systems to use a floating license.

■ Setting up redundant servers.

■ Removing the FLEXlm License Server software.

Note: The information in this chapter is intended for system administrators or users
who manage licenses. If you are using node-locked licenses, see Installing Node-Locked
Licenses on page 25 for information about installing node-locked licenses on a client
system.
13



Setting Up Floating and Named-User Floating Licenses

The steps required to set up floating (temporary or permanent) licenses are described
in the following table.

Table 5 Guide to Setting Up Floating Licenses

To Procedures

Set up floating licenses 1 Make sure your license server and clients can work
with the network configuration that you have set up.
See Working with a Supported Network Configuration on
page 15.

2 Install the FLEXlm license server software on the
license server system. See Working with a Supported
Network Configuration on page 15.

3 Install the evaluation or permanent floating license
keys on the license server system. See Installing
Floating License Files on page 18.

4 Start the license server software. See Starting the License
Server on page 20.

5 Configure the client to use license keys from the server.
See Configuring the Client System to Use a Floating
License on page 22.

Set up named-user floating
licenses (only applies to Rational
Purify, Quantify, and
PureCoverage)

1 Make sure your license server and clients can work
with the network configuration that you have set up.
See Working with a Supported Network Configuration on
page 15.

2 Install the FLEXlm license server software on the
license server system. See Working with a Supported
Network Configuration on page 15.

3 Install the evaluation or permanent floating license
keys on the license server system. See Installing
Floating License Files on page 18.

4 Start the license server software. See Starting the License
Server on page 20.

5 Create a FLEXlm options file on the license server.
Configuring the Server for Named-User Floating Licenses
on page 21

6 Configure the client to use license keys from the server.
See Configuring the Client System to Use a Floating
License on page 22.
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Working with a Supported Network Configuration

This section provides important information about network configurations.

Dial-up Support

You can use floating licenses with a dial-up network connection that supports a
constant TCP/IP connection to the FLEXlm license server. Any client must have a
constant TCP/IP connection to the license server.

If the dial-up connection is lost while a client has checked out a floating license, the
server will automatically reclaim the floating license. When the connection is lost, the
client cannot periodically “talk” to the license server to refresh its license. Because the
client cannot refresh its license, the Rational product will run for a limited period of
time. This time period is product dependent.

WAN Support

Rational floating licenses can be used over a wide area network if this is in compliance
with the geographical allowance of the License Agreement.

If you choose to run licenses over a WAN, be aware of how your systems resolve
hostnames. Rational recommends, but does not require, that you always use the fully
qualified domain names in the SERVER line and on the clients. This technique tends
to reduce the number of issues with hostname resolution.

Novell Support

Rational’s FLEXlm implementation does not support Novell Netware 5.0 or later
directly with floating licenses. Rational floating licenses can be used in a Novell 5.0
environment that is configured with TCP/IP and/or IPX.

Node-locked licenses with Novell 5.0 are supported.

Configure redundant license
servers

See Setting Up FLEXlm Redundant Servers on page 22

Reviewing license file information See Reviewing Your License Information on page 19.

Remove the license server
software

See Removing the FLEXlm License Server Software on
page 24.

Table 5 Guide to Setting Up Floating Licenses

To Procedures
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Installing the FLEXlm License Server Software

To install floating licenses, you must install and configure the FLEXlm License
Server. This section describes how to use the Rational Software Setup program to
install the FLEXlm License Server, a software-based license server that allows you to
flexibly install and manage license keys.

Before You Install the License Server Software

The following sections provide requirements for installing the license server.

Installation Requirements

The following table lists the system and software requirements for installing the
FLEXlm License Server software.

Note: Make sure that you have a current backup of your Registry and system
directories before running the Rational Software Setup program.

Default Installation Path

The Rational Software Setup program uses C:\Program Files\Rational as the default
installation path. If your C:\ drive lacks sufficient free disk space, you may either
specify another drive or make space available on the default drive.

Warning: Interrupting an installation that is in progress may leave your system in an
indeterminate state. If you try to close the Rational Software Setup window
while the installation is in progress, the Setup program asks you to confirm
that you want to exit from the incomplete installation.

Table 6 FLEXlm License Server Requirements

Item Requirement

Operating System Microsoft Windows NT 4.0, SP2 or greater.
Microsoft Windows 2000.

Processor 133 MHz or greater.

Memory 64 MB.

Disk space 1.8 MB.

Privileges Windows NT administrator privileges on the local
system.
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Using the Rational Software Setup Procedure

This section describes a Typical installation of the FLEXlm License Server software.

1 Insert the Rational Solutions for Windows CD into your system’s CD drive.

The Rational Software Setup program starts automatically.

If autorun is disabled on your system, click Start > Run and enter
drive: \Setup.exe where drive is the letter of the CD drive.

2 The Rational Software Setup dialog box provides general information about the
software installation.

3 On the Select Installation Option dialog box, choose Install License Server.

4 Choose to accept or not accept the Rational Software license agreement in the
License Agreement dialog box.

❑ If you accept the license agreement, the Setup wizard continues.

❑ If you do not accept the license agreement, you cannot continue with the Setup
program. Exit the Setup program by clicking Finish or Cancel. When you exit
from the Setup program, the Setup program makes no changes to the system.

5 The Setup Configuration dialog box displays the setup options for the software.
The only choice available for the FLEXlm License Server is Typical.

6 The Upgrade Compatibility dialog box appears if you have additional, older,
Rational products installed on the system. Because Rational tools share files and
components, this installation can cause the older Rational products to stop
working. You will see no visual clue to indicate that the older products may be
compromised.

For each of the additional, older products listed, we strongly recommend that you
do one of the following:

❑ Upgrade it: Complete this installation, and then restart the Setup program to
upgrade the listed products. Upgrading each product updates all necessary
files, registry entries, startup menu items, and shared components on your
system. See the product-specific upgrade section in Installing Rational Suite for
requirements.

❑ Remove it: Complete this installation, and then see Installing Rational Suite for
the removal procedure.

7 The Confirmation dialog box displays the product features that will be installed.

8 The Error Summary dialog box displays errors from the first part of the Setup
program. If the installation is successful, you do not see this dialog box.
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The Rational Software Setup program writes a log of installation activities. The log
file is located in <Install Path>\Rational\RSSetup\RSsetup.log.

Possible Reboot Required

If files required for the installation are in use during the Rational Software Setup
program, and if the program needs to install shared components on your system, the
Setup program may need to reboot your system. After rebooting, do the following:

1 Log on as the same administrator to complete the installation procedure. If you do
not log on as the same administrator, the installation does not complete correctly.

The installation process completes on your system.

2 Click Finish.

Note: After you install the FLEXlm License Server software, install the license keys on
the license server before you start the license server.

Installing Floating License Files

This section describes how to install permanent or evaluation license keys on the
license server system.

Installing Permanent or Term License Agreement (TLA) License Keys

When you have requested your license keys using Rational AccountLink or the fax
form described in Requesting Permanent License Keys on page 11, Rational sends you a
permanent floating license file.

To open the License Key Administrator (LKAD) and install the permanent license file
on the license server:

1 From the Windows Start menu, click Programs > GLOBEtrotter FLEXlm License
Server > Rational License Key Administrator. The License Key Administrator main
window and the License Key Administrator Wizard dialog box appear.

2 Install the permanent license file from the LKAD main menu or the LKAD Wizard.
Look under Working with Floating Licenses in the Rational License Key
Administrator online Help. Click the Installing a Permanent or TLA Floating License
Keys topic.
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Entering Temporary or Evaluation License Keys

You may enter a temporary or evaluation license key on the FLEXlm License Server to
let client systems request a floating license key from the Server.

The temporary or evaluation license key information, including the expiration date, is
on your License Key Certificate. The License Key Certificate is enclosed in a large
green envelope in your Rational Software product shipment.

To open the License Key Administrator (LKAD) and enter the evaluation license key
on the license server:

1 From the Windows Start menu, click Programs > GLOBEtrotter FLEXlm License
Server > Rational License Key Administrator. The License Key Administrator main
window and the License Key Administrator Wizard dialog box appear.

2 Enter the temporary key from the LKAD main menu or the LKAD Wizard. See
Installing a Temporary Floating License Key under Working with Floating Licenses in
the License Key Administrator online Help for any questions you have about
entering a temporary or evaluation license key.

Reviewing Your License Information

By default, you should see complete information about your license keys in the main
window of the License Key Administrator. If you do not see this information in the
window, use the View > Show menu to display information about your licenses.

The following table defines each of the options in the View > Show menu.

Table 7 Show Licenses

License Shows

Invalid and Expired Licenses All expired node-locked, floating, and served licenses
on the system that you are using

Floating Licenses All floating licenses on the system that you are using

Node Locked Licenses All node-locked licenses on the system that you are
using

Served Licenses All floating licenses that Rational software on your
system could request from the license server
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Starting the License Server

The License Server software requires no configuration. Start the FLEXlm License
Server after you have installed the floating license keys.

Note: The FLEXlm License Server will not start until floating license keys are
installed.

Starting the License Server on Windows 2000

1 Click Start and select Settings > Control Panel > Administrative Tools > Services >
FLEXlm License Manager.

2 In the General tab, click the Start button under Service Status.

Starting the License Server on Windows NT

1 Click Start and select Settings > Control Panel > Services.

2 Select the FLEXlm License Manager in the Services dialog box and click the Start
button.

Note: Although the control panel applet may still appear on your system from an
earlier release of FLEXlm server software, FLEXlm 7.0 does not use the control panel
applet.

Switching to Manual Startup

The FLEXlm License Server software is automatically set as a Windows NT service.
The default Startup type is automatic, which means the License Server starts
automatically each time you start the system.

Switching Startup Type on Windows 2000

1 Click Start and select Settings > Control Panel > Administrative Tools > Services >
FLEXlm License Manager.

2 In the General tab, select manual under Startup type.

Switching Startup Type on Windows NT

1 Click Start and select Settings > Control Panel > Services > FLEXlm License
Manager.

2 In the dialog box, select manual under Startup type.
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Configuring the Server for Named-User Floating Licenses

Named-user floating licenses behave like floating licenses except you lock the floating
license key to a user or users, allowing user(s) to run Rational software on multiple
systems.

Setting up the FLEXlm Options File on the License Server

You add an entry for each user that will use a floating license in a text file on the
FLEXlm license server. The number of entries in the text file can not be greater than the
number of floating licenses purchased.

1 Create a text file, called rational.opt, in the <rational flexlm dir>\common

directory.

2 Specify the userid for each user that will use the software. To specify the userids,
you use the INCLUDE option in the FLEXlm options file.

The syntax of the INCLUDE option is as follows:

INCLUDE feature_name USER userid

Where:

Examples:

INCLUDE PurifyNT USER jsmith

INCLUDE VisualQuantify USER jsmith

INCLUDE VisualPureCoverage USER jsmith

Note: If you do not use the correct syntax, this feature will not work.

3 You can not have more INCLUDE lines than you have licenses.

4 Restart the FLEXlm server. See Starting the License Server on page 20 for
instructions.

Note: You can edit the options file when the FLEXlm license server is running, but
you have to restart the license server when you have completed the edit.

Item in Options File Explanation

feature_name PurifyNT, VisualQuantify, or
VisualPureCoverage

userid is the username of the user eligible to use the software
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Configuring the Client System to Use a Floating License

You can enter the host name of the license server in either the Rational Software Setup
program or the Rational License Key Administrator (LKAD) on the client system.
Client FLEXlm software files, such as the LKAD, are installed when the Rational
Software Setup program installs Rational products on your system.

■ To specify the license server using the Rational Software Setup program, select
Install Rational Product in the Select Installation Option dialog box. You will see the
Select License Option dialog box.

■ To open the License Key Administrator, click Start > Programs > Rational product
name > Rational License Key Administrator. The License Key Administrator main
window and the License Key Administrator Wizard dialog box appear.

See Specifying the License Server under Working with Floating Licenses in the
Rational License Key Administrator online Help.

Setting Up FLEXlm Redundant Servers

FLEXlm license servers can be set up to run in a fault-tolerant configuration known as
redundant servers. Redundant servers are a system of three FLEXlm servers that work
as a team to manage a single pool of floating license keys. If one of the server systems
goes down, the other two license servers automatically continue managing the license
pool.

Example

You have purchased 25 floating licenses of Enterprise Suite and wish to set up a
redundant server configuration on three Windows systems. You request permanent
keys for the redundant servers using AccountLink. You install FLEXlm on each of the
three redundant server partners; systems A, B, and C. When you receive the license
file of 25 permanent floating keys, you install the license file on each server.

The three servers work as a team to manage all 25 floating licenses in unison. When
you have 20 license keys checked out to your users and system A crashes, systems B
and C continue to manage the 25 licenses.

Warning: It is a common misperception that separating redundant servers across
multiple sites (for example, one in US, one in Europe, one in Asia) provides
maximum fault tolerance. This is not the case. Redundant servers should
always be at the same site and on the same subnet.
22 Chapter 4 - Installing Floating and Named-User Licenses



Get Your License Keys for the Redundant Servers

Go to AccountLink (www.rational.com/accountlink) and request licenses for the
redundant servers. (If you do not have an internet connection, see Requesting
Permanent License Keys on page 11.) In AccountLink, specify the redundant servers in
the following order:

■ Primary license server
■ Secondary license server
■ Backup license server

The client machines communicate with the redundant servers in that order so
generally the primary license server is the most stable machine.

Set Up Redundant License Servers

1 Install FLEXlm license server software on all three license servers. See Working with
a Supported Network Configuration on page 15 for instructions.

2 Import the license file that you receive from Rational licensing services on each
license server. See Installing Floating License Files on page 18 for more information.

3 Start each license server. See Starting the License Server on page 20 for instructions.

Configure Clients to Look at the License Servers

In the License Key Administrator of each client system:

1 Click Settings > Service Configuration.

2 Select Redundant servers and click the Set Up Servers button.

3 Enter the Primary, Secondary, and Backup license server hostnames in the order in
which they were requested in Rational AccountLink.

4 Click OK.
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Removing the FLEXlm License Server Software

This section describes how to remove the license server software from the system.

Before You Remove the License Server Software

1 Make sure that no one is using the license server or any associated files. You
cannot remove files that are in use.

2 Return the license keys to your Rational Account through Rational AccountLink
(www.rational.com/accountlink), the online license management tool. For more
information about moving or returning licenses, see Moving License Keys on
page 33 and Removing License Keys on page 34 or look under Answering Frequently
Asked Questions in the License Key Administrator online Help.

3 To remove the software from a Windows NT system, you must have Windows NT
administrator privileges on the local machine.

Removing the License Server Software

Use the Windows Add/Remove Programs control panel to select and remove the
FLEXlm software. The Rational Software Setup program removes the files from your
system. It does not remove directories that contain files that you created while you
were using the software.

Note: When you use the above procedure to remove a Rational Suite product, the
Rational Software Setup program does not remove the FLEXlm license software and
license files with it.

Next Steps

If you have not already installed your Rational software on the clients, do so now.

If you are interested in using other license server configurations and license file
options, see Using Other License Configurations on page 29.
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5Installing Node-Locked
Licenses
Because a node-locked license is created for a specific system, Rational software can
be used only on that system. You do not need to connect the client system to a license
server; you simply install license keys on the client. This license type allows for
portability, especially for customers who have isolated systems or laptops.

By default, client FLEXlm software files are installed when the Rational Software
Setup program installs Rational products on your system. Although these files are
known as client FLEXlm files, they provide the tools to install node-locked license
keys.

This chapter covers the following topics:

■ Installing Permanent or Term License Agreement (TLA) Keys on page 25.
■ Installing Temporary or Evaluation License Keys on page 26.
■ Reviewing Your License Information on page 26.
■ Next Steps on page 27.

If you are using floating licenses, see Installing Floating and Named-User Licenses on
page 13 for information about setting up floating licenses on a license server system.

Installing Permanent or Term License Agreement (TLA) Keys

When you have requested your license keys using Rational AccountLink, Rational
sends you a permanent node-locked license file. This file contains license keys for the
host that you specified in Rational AccountLink. You can install the permanent license
key file on a client system by either using the Rational Software Setup program or
using the Rational License Key Administrator (LKAD). The LKAD is automatically
installed with the Rational product software.

■ To install the permanent license file using Rational Software Setup, select Install
Rational Product in the Select Installation Option dialog box. You will see the Select
License Option dialog box.

■ To open the License Key Administrator, click Start > Programs > Rational product
name > Rational License Key Administrator. The License Key Administrator main
window and the License Key Administrator Wizard dialog box appear.
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To install the permanent license file, look under the topic Working with node-locked
licenses in the License Key Administrator online Help. Click the Installing
permanent or TLA node-locked license keys topic.

Installing Temporary or Evaluation License Keys

The temporary or evaluation license key information, including the expiration date, is
on your License Key Certificate. The License Key Certificate is enclosed in a large
green envelope in your Rational Software product shipment.

You can enter the temporary license key information on any client system using the
Rational Software Setup program or the Rational License Key Administrator (LKAD).
The LKAD is automatically installed with the Rational product software.

■ To install the permanent license file using Rational Software Setup, select Install
Rational Product in the Select Installation Option dialog box. Next, you will see the
Select License Option dialog box.

■ To open the License Key Administrator, click Start > Programs > Rational product
name > Rational License Key Administrator. The License Key Administrator main
window and the License Key Administrator Wizard dialog box appear.

To enter the license key in the LKAD, see the topic Installing a Temporary
Node-Locked License Key under Working with Node-Locked Licenses in the License
Key Administrator online Help.

Reviewing Your License Information

By default, you should see complete information about your license keys in the main
window of the License Key Administrator. If you do not see this information in the
window, select View > Show > Node Locked Licenses or Floating Licenses to see
information about your licenses.
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The following table defines each of the options in the View > Show menu.

Next Steps

If you are interested in using other license server configurations and license file
options, see Using Other License Configurations on page 29.

Table 8 Show Licenses

License Shows

Invalid and Expired Licenses All expired node-locked, floating, and served licenses
on the system that you are using

Floating Licenses All floating licenses on the system that you are using

Node Locked Licenses All node-locked licenses on the system that you are
using

Served Licenses All floating licenses that Rational software on your
system could request from the license server
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6Using Other License
Configurations
This chapter describes additional FLEXlm configurations that Rational Common
Licensing supports. The first section provides additional procedures for license server
configurations. The second section explains additional license file options. A table in
the beginning of each section provides pointers to specific topics.

Many of the tasks in this chapter are not recommended for the casual or novice user.
Attempt them only if you are familiar with your operating system (or systems),
Rational Common Licensing, and GLOBEtrotter’s FLEXlm.

Other License Server Configurations

The following table provides pointers to information in this chapter about other
license server configurations.

Table 9 License Server Configurations

For more information about See

Monitoring FLEXlm License Server
activity

License Monitoring on page 30

Configuring Windows clients to use a
UNIX server

Windows Clients Using a UNIX Server on page 30

Running multiple FLEXlm Servers on
the same system

Rational and GLOBEtrotter recommend
running a separate lmgrd instance for each
vendor daemon and keeping license keys in
separate files.

Specifying multiple servers in serial This configuration is not possible with the current
Rational licensing implementation.

Multiple FLEXlm licensing on the same
system

Rational and GLOBEtrotter recommend running
a separate license service for each vendor and
keeping license keys in separate files.

Using floating licenses with a firewall Using Floating Licenses with a Firewall on page 30
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License Monitoring

You may need to monitor and report on license usage. GLOBEtrotter offers a robust
solution for license usage reporting called SAMreport. SAMreport is designed
specifically for reporting on FLEXlm server activity. SAMreport offers a full set of
administrative tools that generates reports, graphs, high-water marks, and even sets
alarms to notify individuals when a server has gone down or the license pool is nearly
exhausted. SAMreport works with any vendor's FLEXlm server, not just Rational's. It
is available only through GLOBEtrotter. Detailed information on SAMreport can be
found at: http://www.globetrotter.com/samreport.htm.

Windows Clients Using a UNIX Server

Rational provides license keys that can be served from a UNIX License Server to
Windows clients. Although this manual does not support Rational licensing on UNIX
systems, it can provide the following guidelines:

■ To install the FLEXlm License Server software on a UNIX system, consult a
Rational Software UNIX installation manual if your company has bought Rational
products for UNIX.

■ Use Rational AccountLink and “Getting Started with Rational Software” to request
your license keys. Refer to Rational Licensing Tools on page 2 for more information
about these resources.

■ To point the Windows clients to the UNIX License Server, see Configuring the Client
System to Use a Floating License on page 22.

Using Floating Licenses with a Firewall

Rational’s FLEXlm implementation supports a firewall. To configure licensing with a
firewall, give the Rational vendor daemon and the lmgrd daemon specific TCP/IP
port numbers to run on. The TCP/IP port is used for client/server communication for
floating licenses.

Typically, port values are not pre-assigned so the system can assign them dynamically
to make best use of resources. However, in specialized situations, such as
communicating through a firewall, you need to specify the port numbers so that the
same ones are always used. In a firewall situation, a license request would be routed
to the license manager daemon port (specified in lmgrd Port), which passes the
request to the application using the Rational vendor daemon port (specified in the
Rational Vendor Port).

When you specify the port information, the Rational License Key Administrator stores
the port information in the rational_redirect.dat file, located by default in
\Program Files\Rational\Common.
30 Chapter 6 - Using Other License Configurations

http://www.globetrotter.com/samreport.htm


See Specifying Port Values under Working with Floating Licenses in the Rational
License Key Administrator Help for instructions on assigning port values on a single
FLEXlm license server, redundant license servers, and client systems.

Note: For an overview of the license manager and vendor daemons, see Understanding
the FLEXlm License Server Process on page 44.

Other License File Options

The following table provides pointers to information in this chapter about additional
license file configurations.

Table 10 License File Configurations and Options

For more information about See

Combining license files Rational and GLOBEtrotter recommend
keeping the license keys in separate files.

Home use or travel ■ Rational recommends that you contact a
Technical Support Engineer about setting
up the disconnected use of floating
licenses. See Contacting Rational Licensing
Technical Support on page xi for phone
numbers.

Or
■ Installing Node-Locked Licenses on page 25.

Disconnected use of floating licenses on
Windows systems

Contacting Rational Licensing Technical Support
on page xi. Rational supports this feature, but
recommends that you contact a Technical
Support Engineer for instructions.

Understanding the default order of license
use--in what order does a product use
available licenses on the system?

Licensing Multiple Suites and Point-Products on
page 32

Prioritizing licenses on your system Prioritizing Licenses on Your System (License
Usage Mapper) on page 33

Directing Rational Web products to use Suite
licenses

Prioritizing Licenses on Your System (License
Usage Mapper) on page 33

Upgrading or adding products to your
licenses

Upgrading Your Licenses on page 33 and Adding
Rational Suites or Point-Products to Your
Licenses on page 33

Moving and removing permanent license keys Moving License Keys on page 33 and Removing
License Keys on page 34
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Licensing Multiple Suites and Point-Products

Rational license files indicate whether they are Rational Suite licenses or
point-product licenses. Often, customers install multiple Rational Suite and Rational
point-products on their systems. For example, a customer purchases two types of
Rational Suites and installs them on one system. Or a customer purchases a Rational
Suite and additional Rational point-products and installs them on one system. A
Rational product whether it is installed as part of a Rational Suite or installed
individually requests licenses in this order:

1 Suite license of the last Rational Suite installed

2 Suite license of the Rational Suite installed before the last Rational Suite installed

3 Point-product license

Therefore, a product requests a Suite license before a point-product license if the
product is both part of a Rational Suite and a point-product.

Note: Rational RequisiteWeb and ClearQuest Web, unlike other Rational products,
request a point-product license first. If you would like to change this license use order,
see Prioritizing Licenses on Your System (License Usage Mapper) on page 33.

Example: Rational Suite and Point-Product Floating Licenses

A customer installs several Rational Suite Enterprise licenses and Rational ClearQuest
licenses on its license server. A user installs Rational Suite Enterprise on a client
system. When this user starts ClearQuest, which is a part of Rational Suite Enterprise,
the product requests the Rational Suite Enterprise license before the ClearQuest
license.

Example: Point-Product Node-Locked and Rational Suite Floating Licenses

A customer purchases several node-locked licenses for Rational RequisitePro and
several floating licenses for Rational Suite AnalystStudio. The users install the
Rational Suite and the point-product on their laptops. When they are not connected to
the network, RequisitePro uses the node-locked license. However, when they are
connected to the network, RequistePro requests a floating Suite license first. The users
want RequisitePro to use the node-locked license instead of the floating Suite license
when they are on the network because they do not want RequistePro to use up the
Suite licenses.
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Example: Multiple Rational Suites Floating Licenses

A customer installs several Rational Suite DevelopmentStudio and TestStudio licenses
on its license server. Because DevelopmentStudio was installed last on the client
systems, a product common to both Rational Suites requests the DevelopmentStudio
Suite license first.

Prioritizing Licenses on Your System (License Usage Mapper)

To implement any of the above examples, you can change the default order by using
the Rational License Key Administrator (LKAD) License Usage Mapper.

To use the License Usage Mapper:

1 Select Settings > License Usage Mapper in the menu bar.

2 In the License Usage Mapping dialog box, make sure the correct product is
highlighted in the Installed Products box.

3 Move the product license above the suite license under License Usage Order.

Note: Check the Update the License Usage Settings used by services for web
applications if you want ClearQuest Web and RequisiteWeb to use a Suite license.

4 Click OK.

Upgrading Your Licenses

If you are upgrading from an earlier version of a Rational Suite or point-product, you
can reuse your current Suite and point-product license keys.

Adding Rational Suites or Point-Products to Your Licenses

This section describes the conditions under which you must request new license files.

■ If you have purchased a different type of Rational Suite from the one you are
currently using, you must request a new license file that includes the new Rational
Suite keys.

■ If you are adding a new product to your system, you have to request a new license
file that includes the new point-product.

Moving License Keys

Often, a user replaces an old system or the system administrator decides another
system should act as the new license server. Because permanent license keys are tied
to a system’s host ID, Rational products will not work on another system until you
import new license keys that are tied to the new system’s host ID.
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To move a permanent license, you must first return the license key to your Rational
account. This return transaction credits your Rational account. The credit remains
until you request a license key for a new system.

To perform these transactions, use Rational AccountLink
(http://www.rational.com/accountlink) Rational’s online licensing management tool.

Note: Return the license file before you remove the Rational software from the first
system and install it on another system. For more information, see Answering
Frequently Asked Questions in the License Key Administrator online Help.

Removing License Keys

As mentioned in the previous section, you return license keys to your Rational
account. In Rational AccountLink (http://www.rational.com/accountlink), these
transactions involve a “Return License Key” transaction. AccountLink holds the
licenses in your Rational account until you request license keys for different systems.

Note: Return the license file before you remove the Rational software from the first
system and install it on another system. For more information, see Answering
Frequently Asked Questions in the License Key Administrator online Help.
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7Troubleshooting
Licenses
This chapter provides possible solutions based on commonly asked questions and
error messages.

The commonly asked questions are sorted into the following topics:

■ Node-locked Licenses on page 35.

■ FLEXlm Server and Floating Licenses on page 36.

■ Installing Rational Software and Floating Licenses on page 37.

■ Requesting a License Key on page 37.

■ Moving License Keys on page 38.

■ AccountLink Data Entry on page 39.

■ host ID on page 39.

■ Upgrades on page 40.

An alphabetical list of FLEXlm error messages and possible solutions are in Table 11
on page 40.

Node-locked Licenses

What exactly is a node-locked license? How many users does it support at one
time? Does each additional user cost as much as the first?

A node-locked license supports a single user on a single system. For more
information, see What are Node-Locked and Floating Licenses? on page 5.

Contact your Rational Sales office for information about pricing for node-locked
licenses.
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Does the node-locked software use the IP address as the host ID? We have
DHCP using Windows NT and the software is Rational Rose 98i.

By default, the node-locked license uses the disk_serial_num for the licensed system,
not the IP address. Rational Common Licensing does support the use of static IP
addresses for floating licenses. To find instructions, refer to Contacting Rational
Licensing Technical Support on page xi.

Does a change in the IP address and internet address affect the node-locked
license?

Node-locked licenses use the host ID or disk_serial_num of the licensed system.
Therefore, a change in the IP address or a change in Internet address does not affect
your Rational Software license. However, you should notify Rational Licensing
Support if the e-mail address of the license contact has changed.

FLEXlm Server and Floating Licenses

How do I identify who checked out a license?

It is possible to find out who used which license and when the user did so. If the
FLEXlm license server is installed, click Start > Programs > GLOBEtrotter FLEXlm
License Server > License Tools. License Tools starts the lmtools GUI.

1 Select Configuration using Services in the Mode pull-down menu.

2 Click the Server Status tab and the Perform Status Enquiry button in the Server
Status dialog box.

How do I set up the license server?

For floating licenses, you set up a server by installing FLEXlm License Server software
on a system. Then you request permanent license keys through Rational AccountLink
(http://www.rational.com/accountlink) or other methods mentioned in Getting
Permanent License Keys on page 11.

What does “The license was not intended for this server” mean? I tried to
import a license key file and received a message that reported “The license was
not intended for this server.”

You are trying to install the license key on a system other than the one for which the
license key was generated. The license.upd file specifies the system name and host
ID that you entered in the license key request to Rational. You should either import
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the file on the correct system or you can move the license file to the system that you
are currently using. For more information about moving license keys, see Moving
License Keys on page 33.

Can ClearQuest on a client in one NT domain obtain licenses from a FLEXlm
server that is on a different NT domain?

Yes, it is possible. If the client can “see” the license server by hostname, the request
will work. FLEXlm also supports using the fully qualified domain name or using the
IP address of the license server instead of the hostname.

Installing Rational Software and Floating Licenses

How do I install licensed software on a second disk? I have a second disk on my
machine and I have requested a floating license for <product>.

You can install Rational software on the appropriate disk for your system. See the
online Help in the Rational Software Setup program or see the Installing Rational Suite
manual.

If you have floating licenses, your license keys are tied to the license server, not client
systems. You can install the Rational product on as many client systems connected to
the license server as you would like.

Requesting a License Key

How do I submit fax requests for license keys? Please give me the fax number
to which I can send my request for permanent node-locked licenses. Not all
team members have internet or e-mail so requests need to be centrally
controlled.

See Contacting Rational Licensing Technical Support on page xi for the appropriate fax
number.

Can we request permanent license keys without entering a temporary key?

Yes, you can use Rational AccountLink (http://www.rational.com/accountlink) to
request permanent license keys without first installing your temporary license key.
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How long does it take to obtain the permanent license key?

Rational AccountLink (http://www.rational.com/accountlink) will e-mail you your
license keys as soon as you submit your transaction.

The speed and reliability of your internet connection will also affect when you will
receive your permanent keys.

Moving License Keys

How do we move or transfer a license to another system?

If you want to move a license (floating or node-locked) from one system to another,
first return the license to Rational. Use Rational AccountLink
(http://www.rational.com/accountlink) to notify Rational that you want to return a
license from the old system. Then in a new transaction, request a license key for the
new system. Please return the license keys to your Rational account before you
remove the software from your first system.

How long does it take to move a license key to another system?

The requests for returning and getting a new license key usually take no longer than
your initial license request.

What would happen if I did a clean install of the operating system on my
machine (which would wipe out all the license keys currently on it) without
deleting the license key first? Would it be easy to obtain a new license key or a
replacement for this key?

If you install a new version of the operating system or initialize the disk where your
license keys are stored, you can request a replacement license key from Rational. To
request a replacement, go to Rational AccountLink
(http://www.rational.com/accountlink) and select “Request Copy of a License File.
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How do I move a node-locked license mistakenly installed on a
database/repository server to a client system? We purchased two node-locked
licenses for 2 client systems. I made a mistake and requested and installed one
of the licenses on the database/repository server. I cannot install this license on
the second client because it is system-specific.

If you want to move a license (floating or node-locked) from one system to another,
first return the license to your Rational account. Use Rational AccountLink
(http://www.rational.com/accountlink) to notify Rational that you want to return a
license from the server system. Then in a new transaction, request a new license key
for the client system.

AccountLink Data Entry

What is my Rational Account Number? I just downloaded the upgrade to
<product>. I am now unable to run the software. I do not know my “Rational
Account Number” which is a required field in AccountLink.

Use the Rational Account number specified on your License Key Certificate.

host ID

Why isn’t host ID ffffffff valid? ffffffff is the value listed in the host ID field in the
FLEXlm License Manager.

When you initialized your disk, your disk did not receive a disk_serial_num.
Although the FLEXlm software accepted this entry, Rational's licensing services
regards this value as invalid.

You can reset your host ID by using third-party disk utility tools such as those by
Norton. Another option is to use the Ethernet card address instead of the host ID.

I changed my file system from FAT to NTFS, which changed my host ID. Could
you please change my key to make it work again? I changed my system disk
and the licenses no longer work.

The license keys are generated for a specific hostname and host ID. You have to return
the license keys to your Rational account and then request license keys for the new
host ID. To perform these transactions, connect to Rational AccountLink
(http://www.rational.com/accountlink).
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Upgrades

We received two upgrade packets but chose not to upgrade immediately
because we were in the middle of pre-release testing. The License Key
Certificate says, however, that the key expires on <date>.

Contact your Rational Sales Office to obtain temporary license keys that will work
until you are ready to upgrade your system.

Error Messages

Table 11 lists licensing error messages and their solutions.

.
Table 11 Licensing Error Messages

Message or Condition Description and Action

Cannot find SERVER hostname

Cannot find SERVER hostname in
network database.

The lookup for the hostname on the
SERVER line in the license file failed.

Confirm with your system
administrator:
■ Your system is connected to the

license server (that you specified
in the Service Configuration
dialog box of the License Key
Administrator).

■ The FLEXlm license service is
running on the license server
system.

■ You have entered the correct name
for the license server (in the
Service Configuration dialog box
of the License Key
Administrator).

NO SUCH FEATURE EXISTS

Failed to check out a
<product-name> key.

There is no license key for the
product in the node-locked license
file or on the license server (if your
system is requesting a floating
license key).

Look at your License Key Certificate
to make sure you have a license for
the product. If you do, return the
license file to Rational and request a
new one that contains the correct
data.
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Technical Notes

The Rational Web site contains Technical Notes about licensing issues. For example,
you can use a Technical Note to find out how to:

■ Use the FLEXlm options file to exclude certain users.

■ Troubleshoot the FLEXlm License Server functions.

New Technical Notes appear on a regular basis. Go to http://www.rational.com.
Click Support > Technical Notes > Licensing (Technical Notes Index) to see the Technical
Notes about Rational Common Licensing.

For more technical notes related to licensing Rational Suite, click General or Rational
Suite Enterprise, under Rational Suite (Technical Notes Index).

The license for this product will
expire…

Your temporary or Term License
Agreement (TLA) license key is
nearing its expiration date. To
continue using the product, contact
your Rational Software sales
representative to purchase the
product or extend your TLA.

Click OK to run the product.

This warning message appears each
time you start the application until
you install a permanent license key
or another TLA license key.

You can turn off the warning by
clicking Settings > Display
Expiration Warnings in the Rational
License Key Administrator.

Table 11 Licensing Error Messages (continued)

Message or Condition Description and Action
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8Understanding Rational
Licensing Components
This chapter describes how Rational Software has implemented FLEXlm features and
options in Rational Common Licensing.

Locating the Licensing Components

All FLEXlm software files and Rational license key files are installed in <Install
Path>\Rational\Common\ unless otherwise noted. Client FLEXlm software files are
installed during the installation of Rational software products. FLEXlm License Server
software files are installed on the license server.

Guide to Rational Licensing Components

The following table provides pointers to topics in this chapter.
.

Table 12 Guide to Rational Licensing Components

For more information about See

The FLEXlm License Server components FLEXlm License Server Components on
page 44

Server set up in the license key file Server Setup on page 47

The client configuration in the server set up
process

Client Configuration on page 48

How the license server grants licenses to
clients

License Server Activation Process on
page 48

Floating license time-out period Floating License Time-out Period on
page 49

Restricting access to floating licenses and
other options

Setting up the FLEXlm Options File on
page 49

Rational Common License files More About Rational Common License
Files on page 50

Rational Common License file names License File Names on page 51
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Understanding the FLEXlm License Server Process

The following sections provide information about the FLEXlm license server,
including descriptions of the license daemons running on the server systems.

FLEXlm License Server Components

The FLEXlm license configuration includes these major components, which are
described in the following sections:

■ License manager daemon (lmgrd)

■ Vendor daemon

■ License key file

■ LM_LICENSE_FILE Variable

■ Application program

License Manager Daemon (lmgrd)

FLEXlm uses two daemons (or processes) to manage floating licenses:

■ lmgrd, the license manager daemon

■ vendor daemon

The lmgrd daemon and the vendor daemon work together to manage the license keys.

Supported license key options and examples Supported FLEXlm License Key
Options on page 51 and Rational
FLEXlm License Key Examples on
page 54

Unsupported license key options Other License Key Options Not Used by
Rational on page 57

Diagnostic tools Diagnostic Tools on page 58

Windows registry information Windows Registry Information on
page 58

Other sources of help Additional Help on page 60

Table 12 Guide to Rational Licensing Components

For more information about See
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The lmgrd handles the initial contact with the client application programs, passing the
connection on to the appropriate vendor daemon. It also starts and restarts vendor
daemons.

By default, the lmgrd on Windows is a Windows NT service.

The lmgrd daemon starts on TCP/IP port 27000 (default) when you start the FLEXlm
server. The lmgrd daemon will assign a random vendor TCP/IP port number (unless
you set up a firewall) to the vendor daemon and start the vendor daemon on that port.

License Manager Version

Rational currently ships lmgrd version 7.0 or later with Rational Common Licensing
on Windows and FLEXlm 6.0 or later with UNIX products.

Vendor Daemon

The vendor daemon is a program developed by the software vendor implementing
FLEXlm. The vendor daemon keeps track of how many licenses are checked out and
who has them. Rational’s vendor daemon (called rational.exe) is customized to
behave in a specific manner. Other vendors may customize their vendor daemons to
behave differently.

Rational specifies the path to the rational.exe vendor daemon using the FLEXlm
DAEMON line. Rational also supports specifying the path to the FLEXlm options file
on the DAEMON line after the path to the vendor daemon.

A typical Rational DAEMON line for Windows appears as:

DAEMON rational "D:\Rational\common\rational.exe"

Where:

Item in DAEMON Line Explanation

DAEMON Tells FLEXlm that the vendor’s
license daemon name and path are
specified in this line.

rational The name of Rational’s license
server daemon. Both floating and
node-locked licenses have this
value defined in the DAEMON
string.
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In FLEXlm, licenses are granted by running processes (unless they’re node-locked,
uncounted, in which case they only need to read the license key file to run). There is
one process or vendor daemon for each software vendor (for example, Rational)
which has a FLEXlm-licensed product on the network.

If the vendor daemon terminates for any reason, all users lose their licenses. (This
does not mean the applications suddenly stop running. Users can save their work and
exit safely.) Users normally regain their license automatically when lmgrd restarts the
vendor daemon, although the applications may exit if the vendor daemon remains
unavailable.

The application program communicates with the vendor daemon, usually through
TCP/IP network communications. The application program and the daemon
processes (the license server) can run on separate nodes on your network, across any
size wide-area network.

The format of the traffic between the client and the vendor daemon is
system-independent, allowing for heterogeneous networks. This means the license
server and the system running an application can use different hardware platforms or
even different operating systems (for example, Windows NT as a server system and
Windows 95 as a client).

License Key File

Licensing data is stored in a text file called the license key file. The license key file is
created by the software vendor and is edited and installed by the License Key
Administrator. For details about the files used by Rational, see Table 13 on page 51. To
see a typical SERVER line in a license key file, refer to Server Setup on page 47.

LM_LICENSE_FILE Variable

The LM_LICENSE_FILE variable is used on UNIX systems and on systems with
multiple license key files to set the location of the license file.

D:\Rational\common\rational.exe The path to Rational’s FLEXlm
server executable. The default
value is:
<rational_directory>\
common\rational.exe

Item in DAEMON Line Explanation
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You will not typically need to set the LM_LICENSE_FILE variable in order to use
Rational software products. We strongly recommend that you keep a copy of the
license key file in the vendor’s default location, so that users do not need to set
LM_LICENSE_FILE to run their applications.

Application Program

The application program (for example, Rational TestStudio) that uses FLEXlm is
linked with the program module (called the FLEXlm client library). The program
module provides communication with the license server. With the help of the license
manager daemon (lmgrd), the application program communicates with the vendor
daemon to request a license.

Server Setup

This section explains the line used to set up a server in the license key file.

The FLEXlm SERVER line

A typical Rational FLEXlm SERVER line is similar to the example below:

SERVER curley DISK_SERIAL_NUM=12345678

Item in
SERVER Line

Explanation of Item

SERVER Tells FLEXlm that the license file will be used for floating
or counted node-locked licenses. This is needed in a
floating license file along with a VENDOR or DAEMON
line.

curley The hostname of the license server machine.

FLEXlm allows the license server’s hostname or IP
address to populate the hostname field in the SERVER
line. Rational also allows both values. The hostname
value is not encrypted into floating license keys.

12345678 The host ID of the license server machine.

The default value is the disk serial number
(DISK_SERIAL_NUM) of the user’s boot drive. The
HOST ID value is encrypted into floating license keys.
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Client Configuration

The hostname of the license server or license file is written to the file
rational_redirect.dat in the <rational>\common directory on the client. Rational
does not use the LM_LICENSE_FILE option to specify the location of the license
source.

The rational_redirect.dat file is initially empty. The Rational License Key
Administrator updates this file with the name of your license server(s) when you
select server-based licensing.

Note: Rational Common Licensing on Windows does not use the LM_LICENSE_FILE
variable to specify the location of a license server or file.

License Server Activation Process

When you run a “counted” FLEXlm-licensed application, such as a Rational Suite
product that uses a floating license, the following occurs:

1 The license module in the client application finds the license key file, which lists
the hostname of the license server and the port number of the license manager
daemon, lmgrd.

2 The client establishes a connection with the license manager daemon (lmgrd) and
specifies the appropriate vendor daemon.

3 The lmgrd determines which machine and port correspond to the master vendor
daemon and returns that information to the client.

4 The client establishes a connection with the specified vendor daemon and sends its
license request.

5 The vendor daemon checks in its memory to see if any licenses are available and
sends a grant or denial back to the client.

6 The license module in the application grants or denies use of the feature, as
appropriate.

7 ‘Uncounted’ features, where the number of licenses is ‘0’ (zero), do not require a
server and the FLEXlm client library routines in the application grant or deny
usage based solely upon the license contents. Node-locked licenses, for example,
set the license number to 0 (zero).
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Floating License Time-out Period

The Rational FLEXlm license server reclaims a floating license when the product has
not been used for a default period of 120 minutes. If you use the product again after
the FLEXlm server has reclaimed its license, the product checks out the license again
from the FLEXlm server.

The FLEXlm options TIMEOUT and TIMEOUTALL can be used if the customer wants
to customize the time-out period. The value for each of these options must be greater
than 7200 seconds (or 120 minutes).

The FLEXlm Options File for Floating Licenses

Rational's current implementation of FLEXlm provides the least restrictive licensing
environment possible. By default, the server does not restrict access to any client
requesting a license key. This configuration works best for most customers.

If you want a more controlled floating license environment, you can use the FLEXlm
options file to reserve or deny licenses for certain users, hosts, displays, groups, or IP
addresses. You can also limit the number of licenses each user or group can access.

Rational supports using the FLEXlm options file with Rational Suite 1.1 and higher.

Note: This file applies only to floating licenses.

Setting up the FLEXlm Options File

To use FLEXlm options, create a text file, rational.opt, in the <rational flexlm

dir>\common directory.

Note: For the server to recognize the file or any changes made to it, restart the
FLEXlm server. You will have to stop and then start the license server. The lmreread
diagnostic tool will not work.

Details on FLEXlm options are located on the GLOBEtrotter Web site at
http://www.globetrotter.com/chap6.htm.
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FLEXlm Options File Examples

This section gives two simple examples of how the FLEXlm options file can be used.

Example 1

You may have 10 floating licenses of Rational ClearQuest. You want to ensure that
users Greg and Peter always have a license of ClearQuest available for their use. Set
up the FLEXlm options file as follows:

RESERVE 1 ClearQuest USER greg

RESERVE 1 ClearQuest USER peter

Where:

Example 2

You have 10 floating licenses of Rational ClearQuest. You want to ensure that user Bob
does not have access to a ClearQuest license. Set up the FLEXlm options file as
follows:

EXCLUDE ClearQuest USER bob

More About Rational Common License Files

As a system administrator, you need to be aware of the files used by Rational
software licensing. You will need access to them when you are changing your
license configuration. Table 13, License Key Files, on page 51 describes the license
key files.

The FLEXlm license file is a text file that stores the license key files. Rational creates
the license file based on the information you give to Rational AccountLink.

Item in Options File Explanation

RESERVE Tells the FLEXlm server to reserve a
license

1 Is the number of licenses to reserve

ClearQuest Is the name of the license to reserve

USER Tells FLEXlm to reserve a license for a
specific user id

greg Is the userid for which the license will be
reserved
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The license key file, which is also a text file, contains information about the server
nodes and vendor daemons, and at least one line of data (called FEATURE or
INCREMENT lines) for each licensed product. Each FEATURE line contains a license
key based on the data in that line, the host IDs specified in the SERVER lines, and other
vendor-specific data. For more information about these license key option lines, see
Supported FLEXlm License Key Options on page 51.

License File Names

The following table describes the types of Rational license files.

Supported FLEXlm License Key Options

The following sections describe common FLEXlm options that Rational Software
supports in the Common Licensing FLEXlm license key definition.

INCREMENT

The string INCREMENT tells FLEXlm that the information that follows in the line
defines a FLEXlm license key. Other vendors often define license keys using the
FEATURE option instead of INCREMENT. All Rational license keys use
INCREMENT because it supports the use of the SUPERSEDE option.

Table 13 License Key Files

File Name Description Notes

rational_temp.dat Contains all node-locked
temporary license keys.

You must obtain a permanent
license key to continue to use your
Rational Software product past the
temporary key expiration date.

rational_perm.dat Contains all node-locked
permanent license keys.

Go to Rational AccountLink to
request permanent keys.

rational_redirect.dat Used on a client to specify
the name of the license
server system that
manages floating licenses.

This file is initially empty. The
Rational License Key Administrator
updates this file with the name of
your license server(s) when you
select server-based licensing.

rational_server_temp.dat Contains all temporary
floating license keys on a
license server.

You must obtain a permanent
license key to continue to use your
Rational Software product.

rational_server_perm.dat Contains all permanent
floating license keys on a
license server.

Go to Rational AccountLink to
request new permanent license keys.
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SUPERSEDE

All Rational license keys include the SUPERSEDE option. This option tells FLEXlm to
use the most recent INCREMENT line in situations where two license keys with the
same INCREMENT name appear in the same license file.

ISSUED

All Rational license keys include the ISSUED option. The value of the option is the
date on which the license key was encrypted.

VENDOR_STRING

All Rational license keys include the VENDOR_STRING option. This option allows
Rational to include company-specific information in the key, which is generally
product-related. For example, Rational defines the point products in a Suite using the
VENDOR_STRING.

Note: The VENDOR_STRING options and values are encrypted into the key.
Addition or removal of any characters in the VENDOR_STRING will invalidate the
key.

DISK_SERIAL_NUM

The term “host ID” is a generic term that is used to signify something specific to a
machine e.g. the machine’s disk serial number or the machine’s ethernet address.

The HOST ID field is used to associate the key with other entities; the most common
are the ethernet card address or machine’s DISK_SERIAL_NUM (disk serial number).
FLEXlm allows vendors to determine which HOST ID values are acceptable for their
enforcement models.

With Rational Common Licensing, the default HOST ID value on Windows systems is
the disk serial number of the user’s boot drive. In this case the HOST ID field appears
as: DISK_SERIAL_NUM=nnnnnnn. Example: DISK_SERIAL_NUM=12345678.

Running Multiple Operating Systems

In cases where the Windows machine are configured to run multiple operating
systems, the HOST ID routine will continue to return the value of the boot drive’s disk
serial number by default. Rational software licensed to a particular disk serial number
may not work if the act of booting various operating systems results in the boot
drive’s disk serial number changing depending on the operating system used. In
those cases, customers can license the software to the machine’s ethernet card instead
of the disk serial number.
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Using the lmhostid Command to Get the Ethernet Address

Rational allows customers to license Rational software to the value returned by
GLOBEtrotter’s lmhostid command. This is supported on Windows and is the default
for Rational software licensed to UNIX systems. The lmhostid returns the ethernet
address (network id) of the system, which is written in the format
HOSTID=nnnnnnnnnnnn. Do not confuse this format with the disk serial number
format (DISK_SERIAL_NUM=nnnnnnnn) that is referred to in Rational Software
documentation, online Help, and AccountLink as the Host ID.

Forcing the LKAD to Use the Ethernet Address

On Windows systems, the License Key Administrator (LKAD) can be forced to use the
ethernet address instead of the disk serial number by changing a registry setting. To
do this, go the registry under: HKEY_LOCAL_MACHINE\SOFTWARE\ Rational
Software\Licensing\1.0 and set “UseNIC=TRUE”. This will force LKAD to use
the ethernet address rather than the disk serial number.

Note: FLEXlm allows for multiple values of HOST ID to be defined within a single
key, but Rational currently does not support this configuration.

DUP_GROUP

Rational currently supports the use of the DUP_GROUP feature in license keys. The
DUP_GROUP allows the vendor to control the behavior of the key under specific
circumstances. Most products will have DUP_GROUP=UH in their licenses. The UH value
allows a single user to run multiple sessions of a single product (or products in a Suite) on the
same machine at the same time and consume a single floating license.

OVERDRAFT

The OVERDRAFT feature is supported in Rational floating license keys with the value
of 0 (zero) only. This feature enables the vendor to allow their customers to check out
more floating licenses than they actually have purchased. The OVERDRAFT value for
Rational products is set to zero.

Vendor_info

All Rational license keys include the vendor_info option. This option allows Rational
to include customer-specific licensing information in the license key such as the
customer’s account number.

Vendor_info information is not encrypted into the license key.
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NOTICE

All Rational license keys include the NOTICE feature. The value of the NOTICE field
is the customer’s name which is encrypted into the key.

Rational FLEXlm License Key Examples

This section provides examples of Rational FLEXlm license keys for floating and
node-locked products.

Floating License Key for Windows
INCREMENT AnalystStudio rational 1.0 02-MAR-2000 2 D292AB08B025 \

VENDOR_STRING="3121-08471|Floating|0|ClearQuest:1.1, \

RequisitePro:4.0, soda_word:3.5, rose_modeler_windows:6.0, \

UnifiedProcess:5.1" OVERDRAFT=0 SUPERSEDE DUP_GROUP=UH \

vendor_info="999999-0-999|Rational Suite AnalystStudio \

1.0|<B.0.V.>" ISSUED=31-AUG-1999 NOTICE="EBIZ Company" ck=88

Where:

Item in License Key Explanation

INCREMENT Tells FLEXlm that the information that
follows defines a license key.

AnalystStudio Defines the FLEXlm “feature name”.
FLEXlm uses this value as the name of
the license key.

rational The name of Rational’s license server
daemon. It is defined for both floating
and node-locked licenses.

1.0 The license key release number.

02-MAR-2000 The license key expiration date. License
keys with the string “permanent” or
“1-jan-0” in this field do not expire.

2 The license count field. The FLEXlm
server allows two users to use this
license at one time because the value of
the field in this example is “2”.
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D292AB08B025 The license key code. This code is
specific to all the information in the
license key with the exception of the
value of the “vendor_info” field. The key
becomes invalid if any of the
information in the key is changed (with
the exception of the vendor_field).

VENDOR_STRING Allows the vendor to encrypt
vendor-specific information into the key.

3121-08471|Floating|0|
ClearQuest:1.1,RequisitePro:4.
0,soda_word:3.5,rose_modeler
_windows: 6.0,
UnifiedProcess:5.1

The value of the VENDOR_STRING for
a Rational Suite Enterprise license.
3121-8471 represents the product part
number, “floating” indicates the product
is node-locked. The remainder of the
VENDOR_STRING value lists the Suite
point products.

OVERDRAFT Defines the number of licenses FLEXlm
allows the customer to use when the
license pool for that feature has been
exhausted. The value of the
OVERDRAFT field is “0” for all floating
products.

SUPERSEDE All Rational license keys include this
option. Tells FLEXlm to use the most
recent INCREMENT line in situations
where two license keys with the same
INCREMENT name appear in the same
license file.

DUP_GROUP=UH Defines the configuration in which
FLEXlm allows the user to run multiple
sessions with the license key. The value
UH allows the same user on the same
host to run multiple instances of Rational
Analyst Studio with a single license key.

vendor_info="999999-0-999|R
ational Suite AnalystStudio
1.0|<B.0.V.>

The customer’s account number and the
product are defined in this field. These
values are not encrypted into the license
key code.

ISSUED=31-AUG-1999 Defines the date on which the license key
was encrypted by Rational.

NOTICE="EBIZ Company" Defines the customer’s company name.

Item in License Key Explanation
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Node-locked License Key for Windows
INCREMENT RationalSuiteEnterprise rational 1.0 31-DEC-1999
uncounted \

3665A1B59899 \

VENDOR_STRING="3121-08470|NodeLocked||ClearQuest:1.1, \

RequisitePro:4.0, soda_word:3.5, rose_enterprise_windows:6.0, \

TestFactory:7.1, Robot:7.1, TestManager:7.1, LogViewer:7.1, \

VisualPureCoverage:6.0, PurifyNT:6.0, VisualQuantify:6.0, \

UnifiedProcess:5.1 " DISK_SERIAL_NUM=14760cf6 SUPERSEDE \

vendor_info="43999S-0-728|Rational Suite Enterprise 1.0|1.0" \

ISSUED=23-JUN-1999 NOTICE="EBIZ Company" ck=60

Where:
:

Item in License Key Explanation

INCREMENT Tells FLEXlm that the information that
follows defines a license key.

RationalSuiteEnterprise Defines the FLEXlm “feature name”.
FLEXlm uses this value as the name of
the license key.

rational The name of Rational’s license server
daemon. It is defined for both floating
and node-locked licenses.

1.0 The license key release number.

31-DEC-1999 The license key expiration date. License
keys with the string “permanent” or
“1-jan-0” in this field do not expire.

uncounted The license count field. Node-locked
products on Windows have
“uncounted” in this field.

3665A1B59899 The license key code. This code is
specific to all the information in the
license key with the exception of the
value of the “vendor_info” field. The key
becomes invalid if any of the
information in the key is changed (with
the exception of the vendor_field).

VENDOR_STRING Allows the vendor to encrypt
vendor-specific information into the key.
56 Chapter 8 - Understanding Rational Licensing Components



Other License Key Options Not Used by Rational

The information below describes FLEXlm options that other software vendors
commonly include in their FLEXlm implementations. Rational chose not to use these
options because they did not meet a specific license enforcement need.

FEATURE

FLEXlm allows license keys to be defined using the FEATURE option instead of
INCREMENT. Rational uses INCREMENT instead of FEATURE because
INCREMENT supports multiple license keys with the same name in the license file.
Rational does not ship license keys using FEATURE.

UPGRADE

Rational does not use the UPGRADE feature in the INCREMENT line. To define
upgraded products, Rational uses a combination of INCREMENT and SUPERSEDE.

3121-8470|NodeLocked||ClearQue
st:1.1,RequisitePro:4.0,

soda_word:3.5,Rose_enterprise_win
dows:6.0,TestFactory:7.1,Robot:7.1,Te
stManager:7.1,LogViewer:7.1,VisualP
ureCoverage:6.0,PurifyNT:6.0,Visual
Quantify:6.0,UnifiedProcess:5.1

The value of the VENDOR_STRING for
a Rational Suite Enterprise license.
3121-8470 represents the product part
number; “node-locked” indicates the
product is node-locked. The remainder
of the VENDOR_STRING value lists the
Suite point products.

DISK_SERIAL_NUM=14760cf6 By default this is the disk serial number
of the host machine on Windows
systems.

SUPERSEDE All Rational license keys include this
option. Tells FLEXlm to use the most
recent INCREMENT line in situations
where two license keys with the same
INCREMENT name appear in the same
license file.

vendor_info="43999S-0-728

Rational Suite Enterprise 1.0|1.0 "

The customer’s account number and the
product are defined in this field. These
values are not encrypted into the license
key code.

ISSUED=23-JUN-1999 Defines the date on which the license key
was encrypted by Rational.

NOTICE="EBIZ Company" Defines the customer’s company name.

Item in License Key Explanation
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SUITE

Rational does not use the SUITE option to define Rational Suite license keys. Suite
point products are defined using the VENDOR_STRING in the Rational Suite
INCREMENT lines.

Diagnostic Tools

lmtools

The lmtools application from GLOBEtrotter is designed to help diagnose FLEXlm
issues. It is available on Windows only. Rational installs this application with all
products in the <rational>\common directory. If the FLEXlm license server is
installed, you can use the License Tools Start menu shortcut to the lmtools GUI.

lmutil

By default, Rational installs the lmutil program in the <rational>\common directory.
lmutil is fully supported with Rational’s implementation and has a number of useful
options. More information can be found at http://www.globetrotter.com/chap7.htm.

lmreread

The lmutil lmreread command is a supported option that forces the FLEXlm server
to source the license file without having to shut down the server. This allows systems
administrators to make changes to the license file without stopping and restarting the
server.

Note: The lmutil lmreread command does not detect changes to the FLEXlm
Options File on page 49.

Windows Registry Information

This section describes the Windows Registry settings for Rational Software licensing.

Warning: Use extreme caution when editing the Windows Registry! Incorrect edits
can render your system unusable!

Windows Registry entries are located in:

HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Licensing\1.0
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The <Install Path> in the following table refers to the path specified during installation.
The default value is C:\Program Files\Rational.

Table 14 Rational Licensing Registry Entries

Key and Description Default Value

UseLicenseServer

Is this system using a license
server to obtain its license
keys?

FALSE

LicenseRequest

Path of license request file

<Install Path>\common\rational_request.dat

LicenseTemp

Path of temporary license key
file

<Install Path>\common\rational_temp.dat

LicensePerm

Path of permanent license key
file

<Install Path>\common\rational_perm.dat

LicenseServer

Path of file containing name
of license server

<Install Path>\common\rational_redirect.dat

LicenseRequestAddress

E-mail address for sending
license requests to Rational

auto-licensing@rational.com

LicenseServerName

Name of system used as a
license server

This registry entry appears when the system points to a license
server.

ClientInstalled

Does this system have client
software installed?

TRUE

ServerInstalled

Is this system a license server?

FALSE
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Additional Help

FLEXlm Technical Information

For a summary of questions regarding FLEXlm, see the FLEXlm FAQs at
http://www.globetrotter.com/faq.htm.

Licensing Messages

For a description of FLEXlm error codes, see the FLEXlm error code documentation at
http://www.globetrotter.com/chap12.htm.
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Licensing Glossary
AccountLink. Rational’s Web-based license managment tool. Customers can use this tool to request and
return licenses to their Rational accounts.

ANY-HOST. A license key issued for ANY-HOST will run on any system, and is not tied to the
customer's system ID. Startup, Evaluation and Emergency Keys must be configured to run on any
machine, since the Back Office won't yet have the necessary information to encrypt into a specific key

Emergency Key. A temporary key that lets a customer use Rational software for a fixed period of time if
they cannot use their own license for some reason. The duration of the Emergency Key is 5 days.
Emergency Keys can be node-locked or floating. Emergency Keys are distributed by the Licensing
Support Group and run on any host.

Evaluation Key. A temporary key that lets a customer use and evaluate Rational software for a fixed
period of time. Rational Software determines the duration of the Evaluation Key. Evaluation Keys can be
node-locked or floating. Evaluation Keys are distributed by the Sales team and run on any host.

Floating License. A license type that links products to a License Server system. Client systems obtain
licenses from the License Server system when they need to run a copy of Rational software. Multiple
clients can share the pool of floating licenses; one license is granted per client per product. Floating
licenses on License Servers are typically administered by System Administrators.

GLOBEtrotter FLEXlm Server. Software license manager for Windows 95/98/2000, Windows NT,
UNIX, Java, and VMS.

Key Type. Node-locked and floating licenses can be enforced by different types of license keys. The
types of license keys are Startup and Permanent. Evaluation and Emergency keys are variations of
Startup keys, and Term License Agreements (TLAs) are a variation of Permanent keys. Each type of key
has different business rules and policies.

License. A legal right to use a product. A customer receives a license when they purchase the product.
However, they need a License Key to actually associate the product and the system on which it is
running with a license.

License Key. Generic term used in this document to describe keys that enable licenses on a customer
system. The types of License Keys are: permanent, temporary, evaluation, emergency, and Term License
Agreement (TLA).

License Key Administrator. A program written by Rational Software which provides a customer
interface to Rational's Licensing system. The License Key Administrator is installed whenever a Rational
software product is installed on a Windows system. For hosting floating licenses, the License Key
Administrator is installed when the Globetrotter FLEXlm server is installed on a License Server system.

License Key Code. An encrypted code used to enforce a license agreement.

License Type. The valid types of licenses are node-locked licenses and floating licenses. See also Key
Type.

LKAD. Abbreviation for License Key Administrator.
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Node-Locked License. A type of license that links a product to a system. Typically, one node-locked
license is issued per software copy.

Permanent Key. A license that lets customers run Rational products indefinitely. Permanent Keys can be
node-locked or floating. Node-locked Permanent Keys are installed on a client system. Floating
Permanent Keys are installed on a License Server system. Obtain Permanent Keys from the Rational Back
Office. Note: A Term License Agreement, a variation of a permanent key, does have an expiration date.
See Term License Agreement.

Permanent Key Code. The FLEXlm encrypted code that lets a customer run a particular Rational
product using a Permanent Key.

Temporary Key. A short-term license key that lets a customer run Rational software products.
Temporary licenses are not keyed to a specific system. Temporary Keys can be node-locked or floating.
Node-locked Temporary Keys are installed on a client system. Floating Temporary Keys are installed on
a License Server system. Temporary Keys are issued by the Rational Back Office and run on any host
until the specified expiration date.

Temporary Key Code. The FLEXlm encrypted code that lets a customer run a particular Rational
product using a Temporary Key.

Temporary License Key Certificate. A piece of paper or an electronic file that contains information a
customer needs to begin using Rational software with a license. The Temporary License Key Certificate is
shipped to the customer with the software installation media.

Term License Agreements (TLAs). Variation of a Permanent Key. TLAs are issued to a site to let their
employees use Rational software for a negotiated period of time. TLAs are issued by Rational Sales and
have an expiration date.

Vendor. A software supplier using the GLOBEtrotter FLEXlm license server. For example, Rational
Software is a license server vendor.
62



Index
A
AccountLink 2, 7
adding products 33
adding Suites 33

C
changing license usage order 33
combining licenses 31

D
diagnostic tools 58
disconnected use 31
disk space, insufficient 16

E
Error messages 36, 40
error messages 60
ethernet address 53

F
firewall 30
FLEXlm license file

client configuration 48
combining 31
file names 51
license key examples 54
license key options 51– 54, 57
server line 47

FLEXlm license server
activation process 48
components 44– 47
installing 16– 18
removing 24

requirements 16
FLEXlm licensing

configurations 9
software 5

FLEXlm options file 21, 49
FLEXlm technical information 60
floating licenses

description 5– 7
installing 18
reviewing license information 19
See also Named-User floating licenses
set up 14
time-out 49

G
Getting Started with Rational Software, Web

site 2

H
home use. See Disconnected use
Hostid 36

I
installation log file 18
Internet address 36
IP address 36

L
License Key Administrator

administrator privileges 3
description 61
entering licenses 12
license file 48, 51
63



License Key Certificate 2
License key file 12
license key file 46
license key type

permanent 8
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